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i 1.Introduction

VHDL =» Very high speed integrated circuit Hardware Description Language .

Used in testing using simulation for digital systems .

VHDL Design
|

v

Entity
Describe Design Interface (1/0) .

|
Ports Definition
|
' ' }

Name Mode Data Type

Entity Declaration

Architecture Body
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Architecture

Describe Function of the design .

|
’ ’ ’

Behavioral

Data Flow Structural



‘L 2 Entity Declaration

Ex : D-FF :

D —— Q
ok —{ DFF L o

Red bold words =» Reserved words .

entity DFF is
Port (D, Clk : in std_logic ;

Q ,Q :outstd logic) ;
end DFF ;

Port Definition

Name Mode Data Type
User specified . I I | i ] I i l
Don’t use reserved | |
words . In Out Buffer In-Out Boolean Bit , Std_logic
Out with  Bidirectional Bit_vector
internal FB

Library : ieee . Std_logic_1164.all
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i 3.Architecture Bodies

Architecture
|
' ' }

Behavioral Data Flow Structural
1. Process 1. No Process Create using existing
2. Sequential Statements 2. Concurrent Statements designs

Sequential Statements : Used inside a process , ordering of statements is important , because
each statement is executed in order in which it appears .

Concurrent Statements :Executed simultaneously .

Statements inside a process are sequential . processes are concurrent

Process Sensitivity List : Identifies which signals will cause the process to execute “ a change
in sensitivity list would trigger the process “.
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‘L 3.1.Behavioral

Ex : 4 bit comparator : entity eqcomp4 is

Port (a, b : in bit_vector (3downto 0) ;

a __
4 bit  [—equals equals : out bit) ;
b __|comparator
end eqcomp4 ;
architecture behavioral of eqcomp4 is
begin
Note Comp : Process (a, b)
begin
1. Process sensitivity ifa=bthen equals<='1":
list=>a,b.
else equals <="'0";
2. If sta’_celments are end if
SUEMIEY ¢ end process comp ;

end behavioral ;
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3.2.Data Flow

For the 4 bit comparator entity in previous ex :

architecture dataflow of eqcomp4 is
begin
equals <=‘1"when (a=Db) else ‘0" ;

end dataflow ;
Note :

1. No process is defined .

2. Concurrent statements are used “ no sequential statements “ .
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3.3.Structural

Using existed designs =» wire between components using reserved word Portmap
Ex:

U0 : xnor2 portmap (a, b, X) ;

We will make a structural design using existing components and generate its structural
description code “ using simulator “ .
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4.Concurrent

Statements

Concurrent Statements

’ ’

v

Boolean Selective Signal Conditional Signal
Assignment Assignment

1. Boolean Equations : Mux example :

architecture archmux of mux is

begin

X <= (a and not (S(1)) and not (S(0))))
or ( b and not (S(1)) and S(0) )
or (cand (S(1)) and not (S(0))
or (dand (S(1)) and S(0) ) ;

end archmux ;

2. Selective Signal Assignment :

architecture archmux of mux is
begin
with S select
X<=awhen’'00"*;

b when '01;

¢ when 10’ ;

d when others ;

end archmux ;
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i 4.Concurrent Statements

3. Conditional Signal Assignment :

architecture archmux of mux is

begin

when S ='00’ then X <= a Note :

else when S =01’ then X <=b In all concurrent statements
no processes where defined .

else when S ='10' then X <=c¢

else X <=d

end archmux ;
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i 5.Sequential Statements

Sequential Statements
|
} ' ' !

IF Case For Loop Wait
iIf S="00 then X <=a; case S is For variable in init. to final loop Wait for specific time ;
else if S =01 then X <=b; when 00’ => X <=a ; Sequential statement Wait on signal ;
elseif S="10"then X <=c¢; when'0l'=> X <=b ; end loop ; Walit until condition ;
else X <=d; when 10" => X <=c ; Wait ;
end if ; when others => X <=d ;
end case ;
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Part (2) : Simulation
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i 1.Create New Project

File > New > Project

Open HDL designer

Edit Views HOL Tasks Tools Options  Window  Help

@ Design Content. .. 26 B 7
ad g Project... S iewpoint [Fikered] - Dont Touch Hidden ]
Qpen r Library, .. I Language
Close »

omponeat WHOL "33
Component WHOL "33
Page Sefup... o Component WHOL "33
decoder Component WHOL "33
encader Component WHOL "33
Document And Visualize full_adder Component wHDL '93
Exit half_adder Component WHOL "33
pyTED. Ak Component WHOL "33
] e E lab_max_case Component WHOL "33
m ] e E lab_rmaw_if Component WHOL "33
Simulate ] E lab_ riee Compaonent WHOL "33
. I FSR PR Fahran MarmnnRent WHME "33

Press Next

Specify Project name & Location

HQ Creating a New Project @

Flease specify information about the new project

MName of new project;

roject_tsf
Optional short description:
Directory in which vour project falder will be created:

AHDShproject_tst

Mame for the default working library:

 Browse..
b

||3mjec:t_tst_|ib

[~ Advanced

q Mext > P Cancel Help
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i 1.Create New Project Cont.

Project summary =» Press Next Create New Design Files

H3 Project Summary E] H} Project Content E|

“You can add the design data now, or open the project and add them |ater

T Project Directory: C:AHDShproject_tst
. . . (v ian i
Froject File: project_tst hdp @ Dicchia o) onle (3

Froject description: (" Add existing dezign files
Default working library; — project_tst_lib )
" Open the project
Shared Project File: $HDS_TEAM_HOME \shared hdp

Additional librariez can be created wvia the Mew Library wizard

Cancel Help | < Back Ceree] Help

¢ Back

Press Finish
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i 1.Create New Project Cont.

Choose : VHDL File = Combined Specify : Entity , Architecture name

H[3 Design Content Creation Wizard - Specify Content Type [Z| HI} Design Content Creation Wizard - Specify HDL File Name/l ocation E]
Categories: File Types: Creating document: YHDL Entity and Architecture

<&dd Existing HDL Design ta Projects
<&dd Exigting Files to Librarys

In zection: Deszign Filez

Uzing template file: vhdl_combineds.combined. vhd

Graphical Wiew = Ui e SRy Sifersin bt
@ Package Header zing filename rule: Z(entity_name]_%[arch_name].
“erilag File [Z] Package Body File Specification
Registered Yiew [B] Canfiguration Library: |proiect_tst_|ib ﬂ
Text File i
iy [ M
rzhitecture: |BEH_H ﬂ
File name: [He_BEH_HA, [vhd ~| Browse..
File case: |F'resewe caze ﬂ
File format: |F'C j
<1/ >
WHOL Entity and Architecture [WVHDL files are placed in a library's HDL mapping, Side Data or
Downstrean)
v Use Templates
* Usge Default Template
" Wiew Templates on Next Page
" WHDL '87 v WHOL '93
I Mest > I Cancel | Help | < Back |{| Finish |} Cancel Help
Press Finish
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* 1.Create New Project Cont.

In the design manager , you ‘ll find your entity & architecture

H{ Design Manager - Project project. tst

File Edt ‘iew HOL Tasks Tools Options ‘Window Help

[B-=E@-42eX|@s/dEaMn BB 5

Design Explorer [ Using viewpoint : Default Yiewpoint [Filtered) - Dont Tou

Desiqn Unit |Language

HOL

o Companent YHOL '3
New | Add ; Enity YHOL 93
b ba@ BEH_He. Architecture YHOL'S3

2

Check

=
[ == . R T R S e

L L T T e s
[ e R e =R R L BT Tt )

-- VHDL Architecture project tst lih,HA.BEH HA

-- Created:
- by - atudent, UNENOWN (LAE33Z 23]
-- at - 14:10:52 05/ 8/2008

-- uzing Nentor Graphics HDL Designer(TM) 2006.1 (Build 72)

T ieee;
USE ieee.std logic 1164.all;
iees.std logic arith,

ieee library include

Std_logic ibranizs include

CHITECTURE BER HA OF Hi I
BEGIN
D ARCHITECTURE BEH HA;

\Write Your Architechure Here

Fill in your entity & architecture
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‘L 2 Write VHDL Code

Fill in your Half Adder VHDL code

LIERARY ieee:
U3E ieee.std logic 1164.511;
U3E ieee.std logic arith.all;
ENTITY HL I3
portia,biin =td logic: Fort definition
Sum, carry:out std logic):

END ENTITY Hi:

ARCHITECTURE BEH HA OF HA I3

EEGIIN
Ibrocess (a, bl

Egin Function description
um<=a xor b:

arry<=a and bh;
nd process: y
END ARCHITECTURE EEH HAi:
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* 3. Check Errors

Check your code for errors

HY Design Manager - Project project_tst
File Edit Wiew HDL Tasks Tools Options  Window  Help

(-3 &@-%8oX & &20EdHMBH @

b ain

_ Design Unit | Type | Language
HOL [=] [EI] proj t_lib
= Component WHOL "33
Newr | Add B EE}| Ha, Entity WHOL '93
e -] BEH_HA Architecture WHOL 53

aiw - Through Campanents

Generate and runs DesigniChecker
Generate
Designi_hecker

Right-click to change the depth of hierarchy

SimuTafe

Activate your component > Select Check
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Dezign Explorer [ Using viewpoint - Default Viewpoint [Filtered] - Dont Touch Hidde

| B - 08 -

| Time St

Thu bday |
Thu bday 1
Thu May 1



* 4. Start ModelSim

Compile your code & Simulate

HI3 Design Manager - Project project_tst

File Edit Y%ew HDL Tasks Tools Options ‘Window Help

(-2 &RQ-%B2eX @& BEDnMB T D5 &

Design Explorer [ Using viewpoint - Default Yiewpoint [Filtered] - Dont Touch Hidde

t ain

_ |T_1,lpe |Language |Time St
|HDL I
| Component WHDL "33 Thu kday
Mewe ! Add Ha Entity WHODL "33 Thu bay
---ba@ BEH_Ha Architecture WHOL '33 Thu Map
I
Flaw - Single
Generake and run entire ModelSim Flow
enerate
MaodelSim Compile
ModelSim Simulate
Right-click b change the depth of hierarchy | - o T
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Activate your component
Select Simulate

This opens ModelSim



* 4. Start ModelSim

ModelSim Starts > Press OK You ‘Il find in ModelSim your ports , Force an IP and check OP

13 Start ModelSim 6.0-6.2 X

Design | vHDL | Verog | SOF | ] ModelSim St 6.3a

Library: [roseei® File Edt View Complle Smulste Add Transcipt Tools Layout Debug Window Help

Diesign unit IHA N '& - % ‘ Help ’7 &
Wiew: IBEH_HA
W oahd z
Log file: I Fesolution: [, - i @ W E 100 mj l ' w _l} { ‘ Contains ,\‘é 9,\ J La'i"IDUt Simul
Host Mode =
Workspac H 8! |
& Local & Interactive [GUI)
" Remate Server: " Command-ine '11“5':3“[8
Edit Server List | Refresh | 0 |i|'|8_2
[ std_lngic
V' Enable Communication with HDS l Std_ngiE
I~ Ewclude PSL [-nopsl)
[ standard

I~ Save simulator irvoke replay soript in side data directory

Initialization command [-da) Browse Cmd File |
I Edit Crd File |

Additional simulator arguments:

| [~

.. Cancel |
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* 5. Apply IP = Force

To Force a const. IP :

[ ModelSim SE 6.3a
File Edit Yew Compile Simulate Add Objects Tools Layout Debug  ‘Wind nght CI|Ck on Port a
[Ds@a sBEDL2 MED BE@®|| e

J"‘@ﬁ@ ﬁ '“:'D”S:I.J:..* _l}'{_lﬁJJH Conk:

Select Force
Fill in Value = 1

Waorkspar H Al X ([BEERCEaeH
‘l"IInstance
i Wiew Declarati
e = iy Declaration
[~ | :J:;Z: Create Wave ﬁ Force Selected Signal
W std_logic_ Wigw Memary Conbents
Bl standard View Messages Signal Mame: [sim: {haja

Copy .
Find. . Value: [1]

Insert Breakpoink Kind
&dd ko Wave = Freeze { Drive [ Depasit

Add o Lisk

Add ko Log Delay For: |0

Add to Dataflow

Toggle Coverage Cancel After:

Farce...
MoForce
Clock, ..

o4 Cancel

Change...

o v
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i 5. Apply IP = Cloc

Force an IP clock :

ModelSim SE 6.3a

File Edit Wiew Compile Simulate Add Objects Tools Lawout Debug Window Help

DB ®& t2E0 AFS BB |
4 & [ER[ 100nsd RN T |J Contains [ Specify Clock values
Workspar H & X
| e | -
#|Instance [4] Define Clock
- ha
& line_:z iow Declaratt — Clock Mame
4 oot . e Declaration —
= th_lzg:z_ Create Wave |5|m..|'ha.l'|:|
™ sta;dard_ Yiew Memary Contents s "
Wiew Messages |_DFFSEt Dby
Copy "D |5|:|
Find... )
Period Cancel
Insert Breakpaint
Add bo Wave |1|:||:| |
Add o List i
add tao Log — Logic Yalues
Add to Dataflow High: |1 Lo |IZI
Toggle Coverage
Force. . — Firsk Edge
& Rising " Falling
. v
L_||_| _ rI'.Il oK | Cancel
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i 6.Wave Display

Select View > Wave

-] ModelSim SE 6.3a

File Edi |
e
4+

Wiarkspac

E Instance
— ha
9

H stc
o st
W st:

Wigi Cu:umpile Simulate  Add  Objeckts  Tools L

k| - ;
Coverage Cn EE_ u;t
Drataflow

List IS T

Merification Management # L

Locals

Message Wiewer
v Objects
Process
Profiling »
Call Skack,

Waorkspace

Mew Window »

Wave Display Region Appears

s A X
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‘L 6.Wave Display Cont.

7] ModelSim SE 6.3a
File Edit Yiew Compile Simulate Add Objects Tools Lavout Debug MWindow Help

Clameor MES BB e 00 A Sagm|
{@W;lm:‘léj}{_lgﬂﬂ cUntainsliguxw;{

La

% ) ad ”JHUH’«@&
Drag Signals from object view list bﬁ?ﬁﬁiﬁf“ ga|wve - defatt
to wave view list I
] std_'ﬂufc_- B ffior |
Press Run Py Sy |

[7] ModelSim SE 6.3a
File Edit View Compile Simulate Add Wave Tools Layout Debug Window Help

IZEHE BB @ e@s;u&aa\
4 e B e LEERI BTS00

Use Cursor to display signal A o 8 [aaaa]
. . Wor pac Object: Eri: | 7 i

values at certain instant [instance

ha

@ line_=
W std_logic_.
I std_logic_
B standard

‘ J Layout | Simulate
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/.\Working With Blocks

In the following we shall create a full adder from half adder :

To create new design within same library

HR Design Manager - Project project_tst

FEN Edit  wiew HDL Tasks Tools Options Window Help

Design Conkent.. .

-&MI@'E

Project... Default Yiewpoint [Filtered] -

Qpen 4
Close: 3

Library...

Tesk Bench...

Eomponent WHOL "33
Page Setup. ..

Print... CtrHP
Print Hierarchy. ..

Docurnent And Yisualize 3

Exit

An

File > New > Design content

We’'ll create FA from HA using block diagrams

Design Unit
= W projec:t_tst_llb

ITuna

It annuana ITima Gtamn

i} Design Content Creation Wizard - Specify Contant Type

Categaries: File Types:

<Add Exlstlng HOL Design ta Project:> @ Interface
g Files to Librarys % Block Diagrarn B

evi &3] IBD

VHDL Flle %3 State Diagram
‘Werilog File &5, Flow Chart
Registered View B A5

Text File

B Truth Table

)
Files

+ [# DesignChecker

W |+ Documentation & Vi
T UTh

[
|

Select Graphical view = Block diagram

Eng./ M.Ismail



/.Working With Blocks Cont.

Fill in entity name ONLY Fill in Port names for FA , specify Mode

& type as shown

HI} Design Content Creation Wizard - Specify View Name/Location

H[} Design Content Creation Wizard - Specify Interface f5__<

Creating document: Block Diagram The editor below can be used to define the interface.

“You can specify where pou want vour file to be placed, “ou can also use the Signals T able which has more features to define or modify

the: interface |ater.
File Specification
Library name: |pr0iect_tst_lib j Edit your interface here
m@a |bloxck_Fés -l A B _-\—t-\ o
e /fF"Er‘[ Mame Mode Type Bounds
Wigw name: |struct.bd a I std_logic
[Architecture name] \
2 h I std_logic
3 c I std_logic |
\ 5 ouT std_logic
a carry ouT std_logic
G

< Back |(L_ Nth)__)| Firizh Cancel | Help | < Back H Firizh 1 Cancel Help
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i 7.Working With Blocks Cont.

The ports you specified are added :

oo s sosed legie 000 L
. Diagram Signals: 0
S C D e cary

——Ports are added

e R
] Hld Companent Browser. rX‘ lock Diagram
2

HQ Component Browser Dl gl
v oo W ESL DL
PEEg- L -v-o-=--0 0588 &80 ¥-¥-MW-%-@3

JJJ! J J - n project_tst. AddfRemave MaduleWare
%1 blocks

= [P project_tst_lib =l

1+ [E9]

Select Add Component
from upper tOOIbar Component: projeck_tst_lib.HA

Language: VHDOL

|»

@

Tainstance a component, drag onta
i Pl

|w
OLE

Drag two blocks of HA am
to Create your FA Component; project_tst_lib.Ha fHDL).

Toinstance a component, drag onto a
diagram, or uze Copy and Paste.

Eng./ M.Ismail



i 7.Working With Blocks Cont.

From component browser
choose logic > gated OR

!

H[3 Component Browser

d|>|#l[a 7|

+--[_] Constants

----- H N Irput AND
----- Library Cakeqory § Logic

----- T Assign

----- 1 Bit Setter

----- 7 Buffer

----- 1 Bus Driver
3 | i

|

|i

[

[ %

To instance a component, drag onto a
diagram, or uze Copy and Pazte.

b

. Package List
LIBRARY ieee;

_ . USEieesstd logic 164l C 0 00
. USEieeestd logio arthal;

A

o Deelarstions = 0
Ports:
T amage
©B ¢ osedlegit -
Coroonosmdilegic oo oo

. Brofst b

Cba ool

Coreettstlib 00D
HA L

.

Wire all components together
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i 7.Working With Blocks Cont.

From tool bar > ModelSim Icon > Simulate through components

E’,} ign Manager - Project project_tst

B-rFE&P-sBBEX |20 BEHMBH QD L0 BBV -B-MG-3-%-

hain Design Explarer [ Usin_g viewpoint : Default Yiewpaoint [_Filtered_] - Dont Tauch Hidden ] 2|4 EBunch Pad

Design Unit Type Time Stamp
HOL = W project_tst_lib
- @ Component WHDL Thu Map 08 2008 14:55:02
New [ Add =02 struct Block Diagram WHOL Thu bayp 08 2008 14:55:02 w Yhat do you want t

- [ symbol Spmbol WHDL Thu b ap 08 2008 14:55:02 Generate/and rum entire MadelSim Flow (Thro

—a = M HA Comoonent WHDL 92 Thu Maw 08 2002 141746 L e e pp— ] p———

Simulation Results :
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* 7.Working With Blocks Cont.

- 57 Sum r OUT std logic
To display the FA structural code : 55 y -
59 END COMPCONENT:
&0
Design Manager, - Project project_tst 61 —— Cptional embedded configurations
File Edit View HOL Tasks Tools Options ‘Window Help 62 -- pragma synthesis off
63 FOR ALL : HA U3E ENTITY project_tst lib.HA;
64 -- bpragma synthesis on
65
Design U 66
= meje% i 67 EEGIN
Cornnnent W 65
Naal ] —opEn Crk+O R vt 63 -- ModuleWare code(vwl.8) for instance ' 2' of 'oril!
et 70 carry <= carryZ OR carrvyl:
71
e ———— 72
Shows Hierarchy Shift+3PACE 73

Cross-Highlight: 74 P(;)RT MLP |
Update Where Used. .. 75 a => a,
Reports 4 76 b =» h,
Cut Chrl+3 77 Sutn =
Copy Chrl+C 75
Paste Chrl+y hra=]
a0 Paste Special, . S0 T 1 : Hi
Hes Remove From Project —Sl a1 FORT MLF _E
= Fielete Fram Mick riel - =341 = => Sum,
83 u] =>» hi,
54 Surn => 3,
S5 CArry = Carrya
. 86 ;
View Generated HDL 57 J
=1 END struct;
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